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Using ToolBook to Create Application Simulations

Using ToolBook to Create Application Simulations

This tutorial shows you how to use ToolBook to create a software application simulation deployed to the
web as HTML content. For additional information, please refer to ToolBook’s online help system, printed
end user documentation, or contact SumTotal Systems.

Installing ToolBook

Use the installation instructions provided to you in the initial email from SumTotal Systems.

Creating a New ToolBook Book

With ToolBook, you build a learning application by starting a book and adding content such as text,
graphics, assessments, software application simulations, and interactive objects. One way to start a new
book is to use the Book Wizard, which supplies a graphical theme and other objects for the book based
on choices you make in the wizard.

» To start a new book:

1. Open ToolBook. From the Start menu, point to Programs, ToolBook 11, and then click ToolBook
11.

2. Inthe ToolBook Startup dialog box, click Use A Book Wizard.
T ToolBook 11 Startup

fEem Book Use a Book Wizard
Blank The Book Wizards automate the task of creating the layout for a ToolBook
From a Template lesson. These wizards gather input from you about how you want the book

|UseaE|Dth'|l’|zarﬁ 1 to appear and behave.

Open Book
Select a File
Recently Opened Books

Available Types

e Hesotees [ Book Wizard

Getting Started Lesson Design Wizard
Learning / Training

Use the Book Wizard fo creste a book or template based on your
specifications. This Wizard builds 2 book that reflects your input about
page style, and outline for page organization.

Start Wizard

3. Choose Book Wizard from the Available Types, and click Start Wizard.
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4. Inthe Book Wizard, read the first page and then click the Next button.
Book Wizard E|

I|| Book Wizard

The Book Wizard creates the foundation for an orling learning application.

Oni the next few pages, you specify a page style, scoring and logging options, and other
zettings that affect the appearance and behavior of your application. ToolB ook then
creates a book based on pour specifications that you can custonize by adding your own
content.

“V'ou can modify your application at any time by adding text, media clips. hyperlinks.
I interactive objects, and scripts.

Cancel |

5. On the General Information page, enter a title for this book, and then click the Next button.
Book Wizard E|

General Information

Book title:
My course

Book dezcription, copyright, or other information:
Copyright SumT otal Systems

Lthor:
Aaran Smith |

Mext » | Cancel |
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6. On the Page Style page, select Solar in the Page style box. Click the Show preview checkbox to
see a thumbnail image of the style.
Book Wizard r5_<|

Page Style B

A page style determines the araphics and layout.

Fage ztyle: Previgw:
5% Bruzhed Steel (IPhone Portrait) ﬂ
55 Brushed Steel

=% Cumy

55 Fire

5% iPhone (iPhone Landscape)

5% iPhone (iPhone Portrait)

55 Mint

5% Rainbow |
=% Soft Blue [iPhone Portrait) =
55 Soft Blue

% Salar [iPhone Landzcape)
5% Solar [iPhone Portrait

Iv  Show preview
File: Salar.ptp 09/08/2009 23:25: 48

5% Synapse —

Page style directony;
| C:\Program Files\T oolB ook T oclBook 1045 pelstiStyles' =

Last | < Back | Hext » || Cancel |

7. Onthe Book Type page, select the Standard Book option.

Book Type

You can create a randomized quiz or & more book, containing more general content,

" Standard Book

If pou chiooze this option, you will be able to select from a list of available book outlines or create a custom book
outline.

¢ Quiz Book
If pou chooze this option, ToolBook Instructar will create a simple quiz book with & question on each page.

Lazt ¢ Back Cancel
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8. On the Book Outline page, select the Simple Quiz option in the outlines list.
Book Wizard f5__<|

Book Qutline

A boaok outline specifies the types of pages vour application will contain,

Select a predefined book, outling below, or create a cuztom outline,

Defined book outlines: Book gutline:

Simple Training Objectives [Text)

Skill Training Interaction [Multiple Choice Question)

Soft Skillz Training Interaction [Tre-Falze Quastion)

<Cuztom Outline: Interaction (Fill in the Blank Queztion)

<Mo Outlines - Quiz Summary [Quiz Summary with Print Button) -
Simple Quiz Outline - Pravides a basic structure for a A page with & zingle media player. Use thiz page to
qQuiz. present a title, author creditz, and copyright information.

If you want to digplay a compary logo, drag a graphics
placeholder object from the Catalog and drop it on this
page.

Outhire directon:
Ch AT oolBookhT oolB ook, 1045 pelsts Outliness ﬂ

Last | < Back | Mext » || Cancel |

9. On the Page Size page, choose Default page size for style.
Book Wizard rg

Page Size

Select the zize of pages in vour application,

@ Default page size for style
Select thiz option to use the optimal page zize for the style you selected,

" Full screen
Select thiz option ta have your application dizplay at full screen.

¢ Custom page size  [800 & B00 pixels)
Select thiz option to size your application by page units or pisels.

Cancel

Last < Back
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10. On the Scoring page, make sure that the Record score checkbox is checked.
Book Wizarnd ['5_(|

Scoring
Chiooze whether the course will be scored, and where to send the scare,

¥ |
Select thiz option ta enable zcaring during the course session. Usze the optiohs below to specify whao receives
scoring information.

[ E-mnail resulks to studest
[~ E-mail results ba:

[ |

Last | < Back | Mest > || Cancel |

11. On the Logging page, ensure that the Enable logging option is unchecked.

Logging

Chooze whether question answers will be logged. and where to send the log.

[ Enable logging
Select thiz option to enable logging during the course session. Use the options below to specify who receives
the lagaing infarmation.

r

[ |

Last < Back Cancel
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12. The next page of the wizard shows you a summary of the options you’ve selected. Click the Build
button to build your book.

Book Wizard g|
Summary

Book Title Wizard Action: Set Infa_Title property of the boak to My course

Descnption “Wizard Action: Set Info_Description property of the book to Copyright SumT otal
Swstems

Page style file C:\._ASpclsthStyles\Solar.ptp
[File frorm which the page styles are drawn)
Solar

Book Outline
Simple Quiz Outline - Provides a basic structure for & quiz.

Page Size Default Size
This application is shown at the default template size.

Copy | Frint |

| < Back | Build | Cancel |

13. Your new book opens with the Catalog displayed on the left side of your window.

*F ToolBook - (Untitled) (=13
File Edit View Go Insert Object Text Draw Tools Help
gH 0 @ = R=EE I &

Commonly Uzed Objects

3 =
ES—

Auto-Sizing Text Image
Fiel

3

% LESSONTITLE%

[%CHAPTERTITLE%

-
It

=t Lok ]
Bl

2 TOPICTITLE %
Universal Media SmartStyle Button = B o 3 = R
Player Lorern ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod ternpor incididunt ut labore et
v dolare magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullameo labonis nisi ut aliquip:
Aclion Ohjscts = ex ea commodo consequat. Duis aute irure dolor in reprehenderit in voluptate velit esse cillum dolore

eu fugiat nulla pariatur, Excepteur sint occaecat cupidatat non proident, sunt in culpa qui officia

Buttans deserunt mollit anim id est laborurm.

Certificates
Draw Dbjects
Media F'Ia‘yers
Mavigation Objects
Pages 7
Placeholder Objects

. t!uasn;ns
Q‘uwz Summary
Sl A

Simulation Objects

Click Next fo confinue.
Styles

Text Fields
TatalLM s
My Objects

[Pae"Tie" [iisEsa | @ |8 [0 109 B
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Preparing to Add a Simulation

» Add a blank page for the simulation

1.

3.

Navigate to page 4 of the ToolBook book by clicking the right arrow in the status bar at the
bottom of the page.

From the Insert menu, select the option New Page

P ToolBook - (Untitled) |ZHE|[E
File Edit Wiew Go BUEETS

Object Text Draw Tools Help

PO Ee

& d -
Graphic...
Pages...

i R ding. ..
Commonly Used Objec preRerarcing

Action Objects New Simulation,..
Simulation from Recording...

& & LESSONTITLEY
e e

Action Trigger  Rese

@ @ = 2o TOPICTITLE %

[Type your guestion text here. Larem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod
ernpor incididunt ut labore et dolore magna aliqua '

(2] True.
@ E@ = (2)False

Buttons

Delay Action Timer

Certificates

-blaw Obijects
.I_\;iac.lia. F'Iq‘_l;l.er“s
Mavigation Dbjects

Navigation Panels

Pages
Placeholder Dbjects

Questions

~ Click Submif fo check your answer, then click Nexf fo confinue.
Guiz Summmary -

Scoring and Tracking
Styles
Test Fields

Creates 4 new page using the current background.

In the New Page dialog, enter the text Simulation of PowerPoint and click OK.
New Page D—(|

MName of new page:

| Simulation of PowerPoint| |

From Currert Book lFrom Curent Template ] SmartPages ]
Type of page:

® Empty page using the cument backaground

" Page from the cument book: Preview:

-
[ Create a new background for the page

QK | Cancel Help
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Saving a ToolBook Book

» Prepare your book for the next step by saving the book

1. From the File menu, choose Save.

T’ ToolBook - (Untitled)
W Edit View Go Insert Object Text Draw Tools Help
py @0 Ee3&H R
Open... Crl+o L
©pen XML Book,.,

FBEX

Save Ctrl+5

Save As Template... k

'ESSONTITLE%

TERTITLE%

Publish to Web (DHTML). ..

Extensions... Ctr+E
Bound System Books. ., Chrl+y
Print Setup...

Print Pages. .. Crl+P

Print Report,..

Run...

Exit Alb+F4
1 C:\Documents and Settingstshalinim, shalinim . tbl

2 C:\Program Filesi ToolBook) ToolBook, 104tb100ftp exe

3 C:\Program Files\ ToolBooki ToolBook. 10Y|ogread .exe

4 CtiPragram Filesi ToolBooki ToolBook. 10decrypt.exe

G =
Midia Players

Navigatin‘r; Obijects

.N avigation Panels
L i.:.'.a.g.és e

Placehalder Objects

Questions

Guiz Summary

Scoring and Tracking
Styles
Text Ficlds

Saves the current book under a new name.

2. Select OK when the Reset options dialog is displayed.

Save
Save options
{®' PReset book and save
Reset all pages and objects to make them ready Cancel
to run, then save the boolk in that state.

™ Quick save Help
Save without resetting arything. —

3. Typein afile name. For this example, use the name “Test”. Select Save.

10
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Creating a Simulation with ToolBook’s Simulation Recorder

A software simulation can be created quickly with ToolBook by using the Sim AutoBuilder, a simulation
recorder provided with ToolBook. An alternate method is to create the look and behavior of the target
application by using ToolBook’s built-in objects. In this tutorial, we will create the simulation using the
simulation recorder.

Either way, an accurate reproduction of the original software application is produced, with buttons and
menus and other interactive objects that act like the real objects in the original software program. The
simulation can then be deployed as HTML in any combination of Demonstration, Practice, or Assessment
modes.

While you are recording with the Sim AutoBuilder, the mouse clicks, keyboard entries, and other actions
you take are saved each time you press the Print Screen key (or another selected key combination). This
XML-based recording is then imported into ToolBook producing a fully-operational software application
simulation deployable in any combination of Demonstration, Practice or Assessment modes. You can
then edit the simulation using ToolBook’s simulation editor.

» Using the simulation recorder

1. The Sim AutoBuilder is accessed from the Start menu. To launch it, point to Programs, ToolBook
11, Utilities and then select Simulation Recorder.

2. The main screen of the Sim AutoBuilder recording tool is displayed. It shows all of the
applications currently open on the desktop that can be selected for recording. If the application
you wish to record is not open, you can open it and then click the Refresh button on the right.

ToolBook Sim AutoBuilder

Software application(z] to capture:

O[] Microsoft PawerPoint - [Presentationt]
D@ﬂ Froducing Software Application Simulations with ToolB ook, - Microsc

Include applications that open during recarding

Save recorded file to;

D:Mtbrecarding. tr

3. For this example, we will be recording the process of opening a presentation in Microsoft
PowerPoint. Make sure Microsoft PowerPoint is up-and-running on your desktop with an empty

11
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presentation as the active presentation.

A A" B R Presentationl - Microsoft PowerPaint . = x
R
| Home | Insert Design Animations ‘Slide Show Review View @

=X l:l =] Layout ~ | - e | | = - ‘_- 1 Shape Fill - 3 Find

' | S B SR E = :

e | e B2 Reset || e ok Q'ui: [ Shape Outline - | | &, Replace =
=" 7 || siide~ % Delete ‘| o 2 ERre _|= ; G ~" Siyles- = ShopeEffects = || [g Select~

Clipboard = Slides Font s

Click to add title

Click to add subtitle

‘ Click to add notes

Slide1 of1 | “Office Theme" | EEE

4. Make sure Microsoft PowerPoint is listed in the Sim AutoBuilder Application. If it is not, click the
Refresh button. Select Microsoft PowerPoint as the application to capture.

ToolBook Sim AutoBuilder

Software application(z] to capture:
ticrozaft PowerPaint - [Frezentation] oK,
D Producing Software Application Simulations with ToolB ook, - Microsc

Cloze

Settings...

Refresh

About

o] ) e

Help

Include applications that open during recording

Save recorded file to:

|D:\tblecording.tbr i Browse... i

12
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Select the Browse button in the Sim AutoBuilder. Specify a location to save the simulation
recording. You can accept the default file name if you desire.

Save Recorded File To

Savein: |lﬂ ToolBook Guide v| o ? > [~

[EWebExport:

=
& T

Desktop

F
cam §
b= 3 -
T a

3

File name: |tbrecording.tbr b | [ Save l

My Network Save as type: |T00|Book Simulation Recording (™tbr) R | [ Cancel ]

Press the OK button from the main screen of the Sim AutoBuilder. If an instructions dialog
appears, review the instructions and then click the Close button. The Sim AutoBuilder
application is now waiting to start recording Microsoft PowerPoint.

Make Microsoft PowerPoint the activate application by clicking on the Microsoft PowerPoint
application with the mouse. Start the Sim AutoBuilder recording process by pressing the
PrntScrn key on your keyboard. You should now hear a camera shutter. This sound is produced
by the Sim AutoBuilder to let you know it is working. The Sim AutoBuilder also indicates that it is
recording by animating the camera icon in the system tray. If you do not hear the camera
shutter sound, make sure your sound system is on.

Note: You do not have to have a sound card to use the Sim AutoBuilder.

13
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8. Select PowerPoint’s Customize Quick Access Toolbar. Once the menu is fully displayed, press
PrntScrn to record a step using the Sim AutoBuilder.
O ™ I L" E Presentationl - Microsoft PowerPoint - = X

Customize Quick Access Toolbar de Show ew .

. o )|_—| [ 2:‘:1 oS A.| = - g~ LE\P D\_ v &3 Shape Fill ~ 44 Find

| Home Review Vi

+
EE) _J E?Shape Outline ~ {LReplace'
Paste g - Snapes Arrange Quick
| 7 s“dg, , ave 5 il = Siyles - = Shape Effects ~ || [§ Select ~ ‘
|Clipboard ™= | sl E-mail M| Paragraph M| Drawing M| Editing

Quick Print

Print Preview
Spelling
Undo

Redo

Slide Show From Beginning

More Commands...

Show Below the Ribbon Click to add title

Minimize the Ribbon

Click to add subtitle

‘ Click to add notes
Slide1 of 1 | “Office Theme™ | ‘i@ggl‘? (=l ()

9. Select PowerPoint’s Open option. Once Microsoft PowerPoint’s File Open dialog box is
displayed, press the PrntScrn key.

Open |E”z|
Look in: |Eﬂ Sample Files V| @-3 X o =

Mame =

Iy SharePaoint
Sites

,U .

@ 2 Ill
[}
g@’

& Il 2|
@ File: narne: | 5 |
SRR N Files of type: |.¢\II PowerPoint Presentations b |

Open v _Cancel

A

10. Dismiss PowerPoint’s Open dialog by pressing Escape.

11. Define another simulation step in the recording by pressing the PrntScrn key

14
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12. Turn off the simulation recording process by pressing the Ctrl and PrintScrn keys at the same
time.

13. When you finish recording, the Sim AutoBuilder displays a dialog box asking if you want to
perform another recording. Select No.

ToolBook 5im AutoBuilder

Thiz recording iz now finished. The resultz are saved in thiz location:

D Mtbrecording.tbr

To generate a zoftware simulation from this recording, follow these steps:

1. Open ToolB ook, [netructar,
2. Select Simulation from R ecording fram the [hzert menu.
3. Followy the inztructions that appear on the zcreen.

YWhould you like ta perfarm anather recarding?

TEs l [ Mo

14. Next, we will go to ToolBook to import the recording created using the Sim AutoBuilder.

15
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Creating a Simulation from a Recording

ToolBook will now be used to generate the software application from the saved recording produced
when using the ToolBook Sim AutoBuilder application.

» Inserting a recording

1.

Open ToolBook. From the Start menu, point to Programs, point to ToolBook 11, and then click
ToolBook 11.

In the ToolBook Startup dialog box, click Recently Opened Books.

Select the ToolBook book you created previously. If you were following this tutorial exactly, it
will have the file name Test. Once selected, select the Open Book button.

In Author mode, navigate to the page you created previously to place the software simulation.
This should be page 5.

" ToolBook - Test.thk
File Edit %ew Go Insert Object Text Draw Tools Help

BHsn(2EraK-EEe LD ¢ TIFIZ2A|EDSL L

Commonly Used Objects e,

Action Objects

L w9

fiction Trigger  Reset Trigger

QG

Delay Action Timer

Buttong

Certificates

Draw Objects

tiedia Flapers

Navigation Objects

Navigation Panels

Pages
Flacehalder Objects

Questions

Quiz Summary

Scoring and Tracking

Styles
Text Fields

age “Simulation of PowerPoint! X of
Page "Simulation of PowerPoint” 11416,4455 B Sof 10

5. Select the Insert menu.

16



Using ToolBook to Create Application Simulations

Select the Simulation From Recording menu.

I ToolBook - Test.tbk
File Edit View Go BOESGS Object Text Draw Tools Help
=g~ | A0 Ee =S 2HFIIA
Graphic.., L

Pages...

. ¥ R ding...
Commonly Used Objec R REHEramS

Aclion Ohjects Tew Simulation, .
j Simulation from Recording. ., |
- _ h 0
L 4. w® LESSONTITLE%
Action Trigger Rese  MNews Background. .. cirt JAPTERTITLEY
Delay Action Timer
™ W
B —

Buttons
Certificates

Draw Objects
-h;ed\;a. F'Ia;lers.
Mavigation Dbjects
MNavigation Panels
f'ages i
Placeholder Dbjects

Questions

Quiz Summary

Scoring and Tracking
Styles
Text Fields

Create a simulation from a Sim AutoBuilder recording

The Building Simulation dialog box appears. The file name of the most recent recording appears
in the first field.

Building Simulation

Select the recarded simulation file;
I F:hantillesstbrecarding. tor ﬂ

l | Initial mode of the simulation:
. | Dremonsztration ﬂ

~ Automatic navigation during the simulation
Continue simulation after a zpecified time:

[T Demonstration mode
[T Practice mode
[T Aszessment mode

Timed delay bebween stepz [in secands]:

Cancel |

A single software simulation created in ToolBook can be shown in one or more of the following
modes:

17
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e Demonstration mode shows how to complete the task. Typically, there is no user
interaction. The simulation can play automatically or based on the users selecting a key
such as the space bar.

e Practice mode allows a learner to try out each step for a limited or unlimited number of
attempts to complete the step. Practice mode can be scored.

e Assessment mode allows only one answer attempt for each step. This is a type of test and
a score is calculated for each learner who takes the assessment.

For this tutorial, we will use the default simulation mode which is Demonstration. When a user
views the simulation page, this will be the mode in which the simulation runs. This can be
changed later using ToolBook’s Simulation Editor.

Since Demonstration mode is the default selection, select Next in the Building Simulation Dialog

box.

Next, the number of steps in the recording is displayed. Click the Start button to start the
simulation building process.

Building Simulation B3

Recorded steps in the simulation:

H2 Step?2
. l #3  Step 3
Step name:
|Step 1

[7 Create this step on a new page

Show preview [

< Back | Start | Canizel

18
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9. Once the simulation building process is completed, select Finish to go to Author mode.

Building Simulation

The simulation has been created.

Freszs Finish o return to autharing.

10. You will now see the simulation in Author mode.

¥ ToolBook - Test.thk EEX

File Edt View Go Insert Object Text Draw Tools Help

== G2 aKEEEe | J0 Be =S F SR T HDL LA

Catalog X (ol H=92-0:E )+ Presentationl - Microsoft PowerPoint EEe
T —_—

Eomicnlilcad bients | Home | inset  Design  Animations  Siide Show  Review  View @

Astion Objects

(= g =] Layout - FIER] [ = 3 8 5 shape Fill Find
AN e ExIE) e PRy gy :
- =y B Reset = = z A 7 shape Outiine - || 83, Replace -
Paste New - B L U e 8§ AV | = Shapes Arrange Quick
Action Trigger  Reset Trigger ~ J || siige~ % Delete | = £ | S ¥ - = Siyles - = Shape Effects by Select -
Clipbaard = Slides Font & Paragraph & Drawing | Editing
Delay Action Timer
Exit Exit with
confirrnation . .
Click to add title
) -
Buttons
Cetificates Clickto add subtitle
Draw Dbjects !
Media Plaers

Mavigation Dbjects

Navigation Panels

Fages
Placeholder Dbjects

Questions

Quiz Summery

Scaring and Tracking

e

. T
Conlinue
Test Fiskds

Styles

| Button "splitterB a1 of Page "Title'" [ 150007655 [ | B 1010 [¥)

11. To view the simulation as a user, go to Reader mode by pressing F3. Press the Continue button
when prompted.

12. Go back to author mode by pressing F3.
13. Save your ToolBook book by pressing Ctrl-S. Select OK as needed to save the book.

After the simulation is built using the Insert Simulation From Recording option, you may refine the
simulation, such as the default instruction and feedback text, or editing the simulation flow, by using the
Simulation Editor.

19
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Publishing the Software Simulation to the Web

After you finish building your course in ToolBook, prepare it for distribution by choosing Publish to Web
from the File menu. This opens the Web Specialist, which is a wizard that prompts you for information
to deliver your book as a series of deployable HTML files.

» To export a book for the Web and enable SCORM communication with an LMS
1. From the File menu, select Publish to Web (DHTML).

I ToolBook - Test.tbk ['._HEHZl

GICW Edit View Go Insert Object Text Draw Tools Help
Henw... [ = G
Cpen.., Chrl+0
Cpen XML Book. .,

Q| Ee

Save Chrl+5
Save hs...
Save As Template...

% LESSONTITLE%

2 % CHAPTERTITLEY
Extensions., Chr+E
Bound System Books. .. Chri+Y
Print Setup... 2% TOPICTITLE %
Print Pages. .. Ctrl+p Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et
Prink Report... dolare magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco labaris nisi ut aliguip
R ) ex ea commodo consequat. Duis aute irure dolor in reprehenderit in voluptate velit esse cillum dolare
eu fugiat nulla pariatur. Excepteur sint occaecat cupidatat non proident, sunt in culpa qui officia

Exit Ale+F4 ;i L i .

deserunt mollit anirm id est laborurm.

1%\ Test.thk

2 ¥:\httppost.tbk

3 ¥ hUntitled), tblk,

4 ¥:Y@adgets IncGadgets [nc.tbk

st
.i.:.a.gés A
Placeholder Objects
| aueslin.ns
Q‘uiz Summary
Seorng e Tresiing

Simulation Dbjects

Click Next fo confinue.

Shyles

Text Fields
TotallMS
My Objects

Fublishes the curent book to the web

2. The ToolBook Web Specialist appears. Select the Expert button.
ToolBook Web Specialist X
Welcome to the ToolBook Web Specialist.

This specialist will guide you through the steps necessary to prepare your
. l application for distibution on the Word Wide Web.

To continue with the Web Specialist, click MNext.
If you are comfortable with the export options, click Expert.

20
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3. When the first wizard page is displayed, accept the default options. Select Next.
ToolBook Web Specialist X
Select the operations you wish to perform below and click Next.

[v Process your application
. I ™ Transfer your application to a server

Export Now < Back Cancel

4. Onthe next wizard page, accept the default options shown below. Please note that this page
specifies the location to store the Web files. Click Next.
ToolBook Web Specialist X

Desired browser support:

Microzoft Internet Explarer 7.0 and later -
. l | O Microsoft Inkemet Esplarer §.0 -
Firefox 3.0 and later
O Firefox 2.0
O &pple iPhone and iPod Touch 2.0 and later
Apple iPad 3.2 and later
Safani 3.0 and later
O Google &ndroid 1.6 and later
O BlackBemy 6.0 and later -
Create HTML fileg in:
| C\project Web Export\ &
Page Range
s Al
™ Cument page
" Pages:

KN

Enter page numbers and/or page ranges separated by commas.
Bxample, 1,3.5-12

BootNow | <Back [ Neg> |  Cancel

5. You will be prompted to create a folder, Click Yes.
Publish to Web X

' The directory:

£ C:\projectiWebExpart),

does not exist. Do you want to create it?

21
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6.

10.

Next, you are asked if the ToolBook course will be used with a LMS. Leave the default options
alone since for this tutorial the content will not be delivered in a LMS. Select Next.

When the wizard prompts you about the Start page, leave the default options alone. Select
Next.

In the page with options for content loading, leave the default options alone. Click Next.

The Publish to Web Progress dialog box appears. During this process, ToolBook is creating the
HTML pages for the course and inserting the appropriate SCORM communication. After the
export process is finished, click Next.

Note: To view the content in a Web browser, click the Preview button. If you select the Preview
button to preview the Web content, be sure to come back to this Wizard panel and click Next so
the publishing process can continue.

A wizard pane is displayed indicated that ToolBook is ready to produce the SCORM Package file.
Select Next.

After the packaging process is complete, a summary page displays. Select Done to complete the
Publish to Web process.
ToolBook Web Specialist X
The Web Specialist is now finished publishing your content.
| Click. the link below to open the folder containing the launch file [indes. html):
1

C:\projectiw'ebE sporthtesth

Click Done to exit the Web Specialist.

< Back
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Conclusion

We hope that this guide has been helpful. If you have any questions about using ToolBook, please
contact SumTotal Systems.
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